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WELCOME TO QUICKCONFERENCE!

QuickConference is a cross-platform peer-to-peer conversation tool that can be used with or
without an e-mail system. When you need answers now, you can’t afford to wait for e-mail, play
phone tag, or run from office to office—QuickConference is the answer. Its instant messaging

capabilities can save you time and money.

HOW QUICKCONFERENCE WORKS

QuickConference consists of two main components: the client and the server. The client
software is installed on user workstations throughout your network. When users send
QuickConference messages, QuickConference notifies the recipient of the new message and the
real-time “conversation” between the users proceeds on a peer-to-peer basis. This means the
messages only travel between the computers involved in the conference—messages do not have

to be routed through a server.

The Prairie Server is installed on one
machine and it is used to register and
publish which users on the network
are available for conferencing.

Prairie Server is accessed by the
QuickConference client only:

m During automatic refreshes.

m When the client is launched.

m When the client selects the
Refresh button.

m The client accesses user
information on the server for
use in maintaining client

address books.

Welcome to QuickConference
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At 9:00 AM Cindy starts her
computer. An alias for
QuickConference is in the
Startup Items folder, so it is
automatically launched.

As soon as Cindy launches
QuickConference, she is
registered in the server's user
list.

At 9:10 AM Karl launches
QuickConference. The server
registers his name immediately
and he sees that Cindy is
among the users in his user list.

At 9:15 AM Cindy decides to
check with Karl about the 9:30
meeting. Since he's not in her
QuickConference user list yet,
she clicks the Refresh button.
Her list is updated and Karl's
name is now in the user list.
She sends him a quick note
while she’s on the phone and the
business day begins.

How the Prairie Server and clients stay in touch.



TECHNICAL SUPPORT

All CE Software products include the consulting services of an experienced Technical Support
staff. CE Software offers online, fax and telephone support.

Contact Information
Regular hours are Monday through Friday from 8:00 A.M. to 5:00 PM. U.S. Central Time.
CE Software Technical Support can be reached by:
m Phone: 515-221-1803
m Fax: 515-221-1806
m Newsgroups: http://www.help.cesoft.com/
B E-mail: ceonline@cesoft.com

Before You Call

Please verify the following:

m Does your hardware and Operating System version meet the minimum requirements?

m Have you checked the manual or the most updated documentation, located at
http://www.cesoft.com/, to see if your problem is discussed?

m Have you checked the CE Software Technical Support Web page at
http://www.help.cesoft.com/?

m Have you checked the CE Software newsgroups at
http://www.help.cesoft.com/tech/newsgroups.html?

Information you need

To help our Technical Support team assist you as quickly as possible, please have the following
information available when you speak with, or write to, a Technical Advisor:
Product name and version (e.g. InOutTracker v. 1.6)

Serial number. Copy it here for future reference

|
|
m Computer type and model (e.g. PPC 7500/100 or G4/500).
|

Operating system and version (e.g. Mac OS v. 9.1).

e Welcome to QuickConference



SALES AND CUSTOMER SERVICE

CE Software’s excellent Sales and Customer Service staff can answer your questions about

InOutTracker.

Contact Information

The CE Software Customer Service department is open Monday through Friday from 8:00 A.M.
to 5:00 PM. U.S. Central Time. They can answer questions on product availability, upgrades,
product prices, damaged disks, customer registration, and general policies. If you have a
question about your CE Software product, please have your serial number ready when you call.
For customers outside the U.S., please call your local distributor.

m Phone: Domestic orders: 800-523-7638
International orders: 515-221-1801

m Fax: International and Domestic orders: 515-221-2258

m Online: http://www.cesoft.com/service/customerservice.html

Ownership Transfer

If you transfer ownership of a CE Software product, send a letter with the product name, serial
number, your name and the new owner’s name and address to:

CE Software, Inc.

Attn: Ownership Transfer

P.O. Box 65580

West Des Moines, 1A 50265 U.S.A.

Change of Address

If you change your address, please send a letter indicating your old and new address to:

CE Software, Inc.

Attn: Change of Address

P.O. Box 65580

West Des Moines, 1A 50265 U.S.A.

Welcome to QuickConference °
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CHAPTER 1: INSTALLING

Your Network Administrator must have the Prairie Server installed and running with your users’
accounts setup before QuickConference clients can take advantage of instant messaging.

REQUIREMENTS

m 68040 processor or greater
m 16 MBRAM

m System 7.6.1 or greater

m TCP/IP

INSTALLING

1

2
3
4

Insert the QuickConference disk or CD and double-click the client installer icon.
Click the Continue... button on the QuickConference introduction screen.

Read the Read Me and click Continue.

Select a destination on your hard drive for the QuickConference client files and click the
Install button. A progress bar appears.

Click Quit when the installer informs you that installation was successful.

If you have purchased or want to run a 30-day demo of QuickConference’s sister program
InOutTracker, do so at this time.

When installation is complete, you can launch the QuickConference application from the
Apple menu.

2
0’0

Note: An alias of Prairie Client Listener is placed in the Startup Items folder so it is
automatically launched when you restart your machine. PowerBook users may wish to
remove the alias and only launch QuickConference manually when they are connected to
the network.

BACKING UP DATA AND PREFERENCES

Your data and preferences are located in these files and directories. Back these up as often as
practical to avoid the loss of valuable information. It may be convenient to make copies of
these files as soon as you have finished configuring your newly installed software. This may save
time if you need to perform a fresh installation at a later date.

File And Folder Locations

Back up the “Prairie Client Data” folder within the System Folder:Preferences folder. If you
specified a file in which to archive messages (in the General Tab of Options), be sure to back up
your archive file as well.

Chapter 1:

Installing o
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CHAPTER 2: USING QUICKCONFERENCE

LOGGING IN

Prairie Clients

When you first launch the QuickConference client, the

Login screen appears. The Login screen also allows for Prairie LO gin

adding additional users who may want to use
QuickConference from this client. You may delete users
in the same manner. If an existing user’s e-mail address
or servers address changes, choose Edit User to update
the user’s account information. Click OK when New
User... is selected. User

Log me in... — This logs you into the server
automatically, whenever your computer is started, so you
are ready to receive messages immediately.

QuickConference™

[JLog me in automatically in the future

New User...

L1

Cancel I 0K I

% Note: Ifyouhave created more than one user on

your computer, this item is unavailable and the Login
window will open and allow you to choose a user.

You must type the Prairie Server IP number (or machine name, | Enter server address:

if you have a DNS server) that your Network Administrator 192.168.1.2 |

has given you.

Select your name from the list and enter your =—————select New User...
password if you have one and click OK. If you Server: 192.168.1.2

are not in the list, you may be looking at the Home Server ] [other... ]
wrong server. If your Network Administrator has | Select user... User Information
configured the Prairie Server with other servers, h”:ﬂ";;“:ﬂ?';‘ﬂ"r‘:s'mrm e B com
you can select them from the pop-up menu Micky Finn

. Nicole T ti
above the list of names. If they have not been icote Tarranting

setup, you can select the Other... button and
type in the IP address or machine name of the
server you want to access. -

Enter Password:

[cancer] |[ ok ||

Use your mouse or built-in keystroke (38-0)
to select the Other... button.

Chapter 2: Using QuickConference
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THE CLIENT INTERFACE

The QuickConference interface offers quick and intuitive instant messaging for users. The main
conferencing window appears when you launch QuickConference.

Sends messages typed in

the message Field. Opens the tabbed Options dialog.

Refreshes the :
Closes the conferencing window. Transcript pane

user list.
QuickConference HE
T “\ﬁ' Transoript 5 message:s
,©\ e ’-;‘h S Mary Schneider I've gothdr. Smith or/ine one wanting ko -
Refresh  Send  Options  Quit tse hneider@e omparyecorn  CONAMM your 2:30 wppointment tomorrowand [ |
10:55 &b 9122095 M. Robetts on line thres wanting bo kalk o you.
% Home Server | “) || To Mary Schreider  Teli My Smith Il be thers af £:30 and sl Mr. Instant
Randy Anderson 10:55 AM Q422408 Achers fo hold as I'l be off the phons in a
Lou Brown couple minvies. R@PI\}/
Gary Coles Lou Brown I'm looking to move the meeting up to 3:00. IF1 F‘OP—UP
User Jeff Conrad Lot 0 O A C 0T dic would you be ready?
list Dave Cook 11:50 A6 9122095
Rick Fry To Lou Brown Izan be ready by 200,
Pﬁﬂ@ Tim Green 11:51 AM 92208
Cathy Johnson
Craig Jones Lou Brown Allright. I'll move itto 3:00_2<z& vouthen.
Mark Kirk | brot B b Pty c ot
Robert Reed 11:51 204 222198
Mc@@age Mary Schneider -
Liga Smith =
Pa”@ B | I;I:r_]a Taylor Type message here: W
_”S vank/all | can be ready by 3:00. -
Eric wirsos .
Dennis Wright S B
Larry Ziff 4 |
BTN TN TES T B Your Server address: 192.168.1.2 as Devan Bromme| (DEromme l@cesoft.com) | =

The QuickConference main window.

Do Not Disturb

status area
Status area

The status area normally shows your server address and e-mail address. If QuickConference is
getting information from a server, the status area will display the progress. When Do Not
Disturb is turned on the status area will display a red out indicator and flash this icon () in
the Apple menu.

Adjusting Pane Size

To size the three panes in the conferencing dialog, move your cursor over a separator line and
your cursor becomes a sizing tool. Click and drag the selected separator line until the size of the
pane meets your needs.

+ o

{fr? When you position your cursor over the intersection of all three panes, a hand cursor appears.
Use the hand-sizing tool to resize all three panes simultaneously.

Chapter 2: Using QuickConference



QUICKCONFERENCE MENUS

Apple Menu

About QuickConference... — Choosing About QuickConference... opens a dialog box that
shows you the version of QuickConference that is installed, and lists contact information for

CE Software.
File Menu Fite |
) . Refresh ¥R
Refresh — Choosing the Refresh command will cause send
QuickConference to re-list the contents of the User pane. The send Mail =M
. . . . . Close #W
application will refresh automatically every 5 minutes. save Transcript... s
Page Setup...
. . Print Transcript... %P
Send — This command will send your message to the selected D Tanser
. . L. Log Out... #L
user(s). This gives the same results as hitting the Enter key. Change Users... %U
Quit and Stay Connected 30

Send Mail — Choose this command if you want to send mail to the
selected user(s). If you have an Internet style mail client, this
command will open a blank mail message addressed to the intended
recipient(s).

Close — Same as Quit and Stay Connected menu item below.

Save Transcript... — This command will open a standard file section dialog so that you can
save a transcript of your conference as a text document.

Page Setup... — Choosing Page Setup... displays the standard Page Setup dialog box.

Print Transcript... — Choosing Print Transcript... displays the standard Print dialog, allowing
you to print a transcript of your conversation.

Log Out... — This command will quit QuickConference completely and disconnect you from
the Prairie Server. This will also log you out of InOutTracker, if it is running. Other users will
not be able to send you messages after you log out.

Change Users... — This command will log you out of the Prairie Server and then take you to
the QuickConference Login screen. At this point, you will be able to choose another user
name, add another user, edit the information for an existing user, or delete a user.

Quit and Stay Connected — This command will quit QuickConference, it will still be running
in the background and connected to the Prairie Server.

Chapter 2: Using QuickConference @



Edit Menu En

Undo ®e
Undo — This command is not active in QuickConference. It is included | gy —
hili Copy 3#C
on the menu for compatibility reasons. oy e
Clear
. . Clear Transcript... %T
Cut — Choosing the Cut command places the selected text in the gal Transerip
: , : Select All %A
Clipboard and removes it from the text field. e
Change Password...
Edit Address Books...

Copy — Choosing this command places the selected text or transcript
items into the Clipboard.

Paste — The Paste command places a copy of the clipboard contents (if appropriate) into the
text field.

Clear — Choosing Clear will remove the selected text or transcript items.

Clear Transcript... — This command will clear the contents of the transcript.

Select All — Choosing Select All will select everything in the field containing the insertion
point. If used in the user list, it will select all users in the list. If used in the transcript pane, it
will select all listed messages, sent and received.

Options... — This will open the Options dialog. This is where you can set your preferences for
QuickConference.

Change Password... — This command will allow you to change your user password.

Edit Address Books... — Choosing Edit Address Books... will give you the ability to edit,
delete, or create address books. In your address books, you will be able to list users from any of
the servers for which you have access. You can also add an address manually by creating a

Special Address.

DoNotDisturb Menu
I]oNDtI]isturh

None — Choosing None will remove you from Do Not Disturb mode 5 "None =

and make you available for messages from others. I am occupied %1
I amin @ meeting ®2
I am on the phone 3

The available Do Not Disturb messages are listed at the bottom of this Lam out of my office %4

menu. You can edit this list of messages in the Do Not Disturb tab of Other... %6

the Options dialog.

Other... — Choosing this command will allow you to enter a Do Not Disturb message that is

not stored and used only once.

Chapter 2: Using QuickConference



Servers Menu
» None

None — Choosing None will remove references to other servers from your
client’s main window. You will only see those names that are listed on your
Home Serve and names from selected address books, if any.

John's Server

Other available servers are listed at the end of this menu. Only one other sever may be selected
at a time.

AddressBooks Menu

None — Choosing None will remove any address book items from the user list in
your client window. You will only see people listed who are currently available on
your Home Server, or any other selected servers, if any.

AddressBooks

All available address books are listed at the end of this menu. Only one address book may be
selected at a time.

OPTIONS

Choosing Options... from the Edit menu, or clicking the Options button in the main window of
QuickConference, will open a window containing a series of six tabbed sections. Here, you will
be allowed to view user information, set notification options, adjust certain behavioral and
visual aspects of QuickConference, what Do Not Disturb messages are available, and enter your
Instant Replies.

Personal Personal | Notification || General || Views || DoMNotDisturb || Instant Reply |

The Personal tab details information T S S U —
about the current user. It lists the

. First N H D
user’s name, e-mail address, and the L'rst Name BBUD" |
as ame: romme
IP address Of the Prame Server fOI‘ E-mail Address: DErommel@cesoft.com
which you are connected. server Address: 192.168.1.2

[cancet] |[ ok ||

Chapter 2: Using QuickConference @



Notification

When you receive QuickConference
messages, you can choose how you
are notified.

Bring QuickConference to the
front — The main messaging
window appears in the foreground of
your desktop.

Flash Icon (Lﬁ) — Your Apple

menu icon blinks with a
QuickConference icon when you
receive a message. It will stop
flashing when you type or click in
the main messaging window.

Personal I Notificationl General I Wiews I Do Mot Disturb I Inztant Reply I

When I receive a QuickConference message, I want to be
notified in the following wayl(s):

b4 Bring QuickConference to the front
B4 Flash Icon
b4 Play Sound

Notification Sound: [Conference Notify i]

Receive messages from sources whose identity cannot be
verified (if allowed by your server):

[JAccept messages from outside the server ring

[Cancel] ” 0K ]l

Play sound — Your computer plays the sound selected in the Notification sound pop-up menu.

Notification sound — Choose the sound you wish QuickConference to play when a message is
received (must have Play Sound checked above).

Accept messages from... — People can create address books with special addresses to send
messages to people outside of their Server Ring. Since your system cannot verify the identity of
people not on one of its servers, these messages are normally blocked. If you wish to receive
these messages, so you can converse with someone outside of your company, you will need to
check this box and have your Network Administrator configure the server to let them through.
If the server is not configured to allow messages, checking this box will have no effect.

General

Personal I Motification I Generall Wiews I Do Mot Disturb I Inztant Reply I

Adjust options in the General tab to
SpeCify hOW QuickConference [ Send message when Return key is pressed

behaves. [ Show main window when QuickConference is launched
M Select sender when message received

B4 Only if no one else is selected

4 Clear selection after 2 minutes of inactivity
[ Archive messages to file

These options determine how fuickConference behaves:

Send message when... — Select this
option to send messages when you
press the Return key on your

keyboard.

<% Note: Messages are always sent
when you press the Enter key on
the numeric keypad of your (cancer] [[_ox_|J
keyboard, or choose Send from
the File menu, or when you click the Send button on the QuickConference toolbar.

Set archive file

Keystroke to open QuickConference: I:I

Chapter 2: Using QuickConference



Show main window...
QuickConference client.

Displays the main conferencing window when you launch the

Select Sender...
reply quickly.
m Only if no one else is selected — Selects the sender of a message only when no other
item is selected in the User pane.

Automatically selects the sender of a message in the User pane, so you can

m Clear selection after 2 minutes... — Clears any selections in the User pane if
QuickConference is inactive for 2 minutes.

Archive messages to file... — Archives all messages that QuickConference sends or receives for
later review.
m Set archive file...

archive file.

Allows the user to choose the location and name of the text

Keystroke to open... — Specifies a keystroke that opens QuickConference when you are logged

1n.

Views

Fersonal | MNotification | Genetal | Vievsl Lo Mot Disturh | Instant Reply I

Adjust options in the Views tab to
specify how QuickConference sorts
names, displays its Toolbar, and
displays text.

These options determine how QuickConference looks:
M Sort names by last name

B4 Show Toolbar on main window

Display text size

Sort names... — Determines Display text font  (Helvetica =
whether the list of users is sorted by
last name or first name.
Show Toolbar... — Choose whether
or not to display the Refresh, Send,
[cancet] [ ok ||

Options and Quit buttons in the
main conference window. These
commands are also available in the
menus or through keyboard shortcuts.

Display text size... — Specifies the size of the font in the main conferencing window.

Display text font... — Specifies the typeface of the font in the main conferencing window.

Chapter 2: Using QuickConference G



Do Not Disturb Personal I MNotification I General Views Do Not Disturb Instant Reply I

You can customize up to five phrases Edit the phrases for the Do Not Disturb menu:

that will appear on the senders [T am occupied |
screen when you have one of the Do L am in a meeting |
Not Disturb items selected in the [Lam on the phone |
DoNotDisturb menu. [Lam out of my office I

|I am out to lunch

Have InOutTracker check...
you are also using InOutTracker,
generally you want to be out while
you have Do Not Disturb on. Check
the box to have your out status set [Cancel] [ ok ||
when you turn on Do Not Disturb
and in status set when you turn off

Do Not Disturb.

If o Have InOutTracker check me in or out automatically
when I change DND.

Instant Reply

Personal I Notification I General I Yiews I [ro Mot Disturb I Instant Replyl

Allows you to customize up to seven

Edit the phrases for Instant Replies:
phrases that can be quickly entered

Yes
from a pop-up menu for fast replies. IN" I

|Please take a message. |
Send reply immediately... If |Please have them hold, I'll bhe off in a minute or two. |
checked the Instant Reply that you [Thank you. |
SeleCt from the POop-up menu in the |Please see me when you have a minute. |
main Wil’ldOW Wlll be sent right away |Mg call just got longer, please take a message for me. |
without the need to press the Send O send reply immediately on Instant Reply selection,

do not wait for Send Button.

button.

[cancet] |[[ ok ||

SENDING MESSAGES

To conference someone listed in the User pane, follow these steps:
1 Select a user from the User pane by clicking once.

% Note: Send to multiple users by pressing the Shift key to select adjacent users or the
Command key to select nonadjacent users. Double clicking any received transcript item
will select the sender’s name in the User pane.

2 Type your message in the Message pane (up to 512 characters).

3 Click the Send button or the Enter key on the numeric keypad of your keyboard.

@ Chapter 2: Using QuickConference
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Note: Select the “Send message when Return key is pressed” option, in the General tab of
the Options dialog, to send messages when you press the Return key. Double clicking a
User, Address Book or Server will also send your message; you can also choose Send from
the File menu, or clicking the Send button on the QuickConference toolbar. Double
clicking an Address Book or Server will send the message to everyone listed in the Address
Book or Server.

When the recipient responds to your message, you are notified by the method you specified in
the Notification tab of the Options dialog. The response appears in your Transcript pane in
plain text.

% Note: Double clicking a sent transcript item will show a list of the recipients for the

message.

Conferencing Over the Internet

You can conference over the Internet if:
m  You are connected to the Internet.

B Your Server Address field is set to communicate with a remote Prairie Server.

Launching URLs

When you send messages to other QuickConference users, you can include URLs to Web sites.

The URLs are blue and underlined and all the recipient has to do when they receive the URL is
double-click it. If you are using a Mac-OS based computer and Internet Config is installed, the
selected Internet browser launches and opens the URL. Some examples of valid URLs include:

m http://www.cesoft.com
m ftp://ftpts.cesoft.com/

B mailto:ceonline@cesoft.com

RECEIVING MESSAGES

When you receive a message, it will appear in the transcript in a different color so that you can
easily see what new messages have come in. If you have the Notification tab option for Flash

Icon checked you would also get this notify icon ( -cﬁ) in the Apple menu. The transcript will

change color and flashing icon will stop when you send a new message, close QuickConference,
or do a manual refresh.

ADDRESS BOOKS

A user can create and maintain up to 30 address books. An address book includes the names of
the users that an individual might communicate with on a regular basis or it might consist of a
whole department of people such as Sales or Accounting. The QuickConference client can
toggle between any or none of the Address Books by pulling down on the Addresses menu.

Chapter 2: Using QuickConference @



The names of the users in the Address Book will appear in your user list above your Home
Server. If a user is on-line, and is able to receive a message, their name will be displayed
normally. A user’s status could also be off-line (unable to receive a message) or his or her status
could be unknown.

If a user’s status is off-line (again, unable to receive a message), the No symbol ( #} ) appears by

this person’s name.

If a user’s status is unclear or unknown, the Question Mark ( 2 ) will be displayed next to his or
her name. If the user has a version of QuickConference that does not accept encrypted
messages, a Lock Icon ( [ ) shows next to their address and messages to them are sent

unencrypted. If the user is able to receive a message, then the message is sent normally. If the
user sends a message, and it turns out that the intended recipient is off-line, then a message will
appear stating that he or she is in off-line after a brief pause.

% Note: The Question Mark will appear if the name in the Address Book is registered on a
server that is not displayed in the main window.

Editing Address Books

Select Edit Address Books... from the Edit menu. This will bring up a window with which to
create, rename, edit and delete address books.

To create a new Address Book click New... and then enter the name of the Address Book in the
window provided. Once the name is entered, click OK.

On the left, the screen now llst§ the users (Wome Server B oddress Book: Mine
from the server that is selected in the pull
X . Devon Brommel Devon Brommel
down menu above the list. The right box Mary Kay Farnsworth Mary Kay Farnsworth
s . Micky Fi Micky Fi
will include the user names in the Address NCo e Tarrariirs xRy
Book that is being created or edited.
Use your mouse or built-in
keystrokes to select these items.
#8-A to Add an address. =] B
8-E to Edit an address.
88-D to Delete an address. Add>> | [ Edit.. | [ Aad Special... |
8-S to Add a Special Address.

Double clicking or selecting and clicking
the Add>> button will move a user into the Address Book. A user in the Address Book can be
deleted by selecting the user and clicking the Delete... button.
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Edit and Add Special

A name in the Address Book may be edited by selecting it and clicking the Edit... button or by
simply double clicking a name.

A name can be added directly to the address book by clicking the Add Special... button and
filling in the name, the e-mail address, and the IP number of the recipient’s Prairie Server.

> IMPORTANT: The E-mail Address and Server Address must match the information entered

on the server when editing or creating a special address. If this information is not correctly
entered, there is no warning and the name will continually have the No symbol () listed

next to it.

SERVERS

QuickConference will default to display the user’s Home Server and those users from the Home
Server who are currently logged onto the system. If the server software is set to link to any other
Prairie Server(s), they will be listed in the client’s Servers menu. The QuickConference client
can toggle between any or none of the listed servers. Once a server is selected, it and its on-line
users will be listed below the Home Server.

Chapter 2: Using QuickConference a



Chapter 2: Using QuickConference



INDEX

Symbols

- Do Not Disturb Icon DHD 12
- Lock Icon 5 20

- No symbol {# 20, 21

- Notify Icon -Eﬁ 16, 19

- Question Mark ? 20

A

About QuickConference... 13
Accept messages from... 16
Add Additional User Account 11
Address Books 19

Editing Address Books 20
Editing Addresses 21
Special Addresses 21

Adjusting Pane Size 12

Archive messages to file... 17

B

Backing Up Data and Preferences 9
Before You Call 6

Bring QuickConference to the front 16

C

Change of Address 7

Change Users... 13

Clear 14

Clear selection after 2 minutes... 17
Clear Transcript... 14

Client Interface 12

Close 13

Command key 18

Conferencing Over the Internet 19

Contact Information

Sales and Customer Service 7
Technical Support 6

Copy 14
Cut 14

Index

D

Delete User Account 11
Display text font... 17
Display text size... 17
DNS server 11

Do Not Disturb Tab 18
DoNotDisturb Menu 14

E

E-mail address 11, 12
Edit Address Books... 14
Edit Menu 14

Edit User Account 11
Editing Address Books 20

F

File And Folder Locations 9
File Menu 13

Flash Icon 16

G
General Tab 16

H
Have InOutTracker check... 18
How QuickConference Works 5

I

Information you need 6
Installing 9

Instant Reply 18

Instant Reply Pop-up 12
IP Address 11

K
Keystroke to open... 17

L

Launching URLs 19

Log me in automatically 11
Log Out... 13

Logging In 11



M
Menus

About QuickConference... 13

AddressBooks Menu 15
None 15

Apple Menu 13

Change Password... 14

DoNotDisturb Menu 14
None 14
Other... 14

Edit Menu 14
Change Password... 14
Clear 14
Clear Transcript... 14
Copy 14
Cut 14
Edit Address Books... 14
Options... 14
Paste 14
Select All 14
Undo 14

File Menu 13
Change Users... 13
Close 13
Log Out... 13
Page Setup... 13
Print Transcript... 13
Quit and Stay Connected 13
Refresh 13
Save Transcript... 13
Send 13
Send Mail 13

Servers Menu 15
None 15

N
Notification Sound 16
Notification Tab 16

(0]

Only if no one else is selected 17

Q

Options

15

Do Not Disturb Tab 18

Have InOutTracker check... 18

General Tab 16

Archive messages to file... 17
Clear selection after 2 minutes... 17

Keystroke to open... 17

Only if no one else is selected 17

Select Sender... 17

Send message when... 16
Set archive file... 17
Show main window... 17

Instant Reply 18

Noti

Send reply immediately... 18

fication Tab 16

Accept messages from... 16
Bring QuickConference to the front 16

Flash Icon 16
Notification Sound 16
Play Sound 16

Personal Tab 15
Views Tab 17

Options..
14

Other...

Display text font... 17
Display text size... 17
Show Toolbar... 17
Sort names... 17

. 14

Other... button 11

Ownersh

P

ip Transfer 7

Page Setup... 13

Password 11

Paste 14
Personal

Tab 15

Play Sound 16
Prairie Server IP number 11

Print Transcript... 13

Q
Quit and

R

Stay Connected 13

Receiving Messages 19

Index



Red DND Indicator 12
Refresh 13
Requirements 9
Return key 19

S

Sales and Customer Service 7
Save Transcript... 13

Select All 14

Select Sender... 17

Send 13

Send Mail 13

Send message when... 16
Send reply immediately... 18
Sending Messages 18
Server Address 12

Servers 21

Servers Menu 15

Set archive file... 17

Shift key 18

Show main window... 17
Show Toolbar... 17

Sort names... 17

Status Area 12

Status Icons 20
Lock Icon 20
No symbol 20
Question Mark 20

T
Technical Support 6

U

Undo 14

URL 19

Using QuickConference 11

\"
Views Tab 17

Index



NOTES

e Index



CE SOFTWARE LICENSE AND LIMITED WARRANTY AGREEMENT

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE USING THIS PACKAGE.
BY USING THIS PACKAGE, YOU AGREE TO BECOME BOUND BY THE TERMS OF
THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT
USE THE SOFTWARE AND PROMPTLY RETURN THIS PACKAGE TO THE PLACE OF
PURCHASE FOR A FULL REFUND.

DEFINITIONS

The following definitions apply to the terms as they appear in this agreement:

+ You and Your refer to any person or entity that acquires or uses this Package.

« Package means the Software, manual(s), and other items accompanying this agreement.

« Software means the computer program contained in this Package, together with all codes,
techniques, software tools, formats, designs, concepts, methods, and ideas associated with that
computer program. It also means any copies of the program, codes, etc. made to any other
diskette, hard disk or other media.

+ Authorized Number means the maximum number of licensed users that may use the
Software, which is one unless a greater number is indicated on the Package.

« Diskette, by definition, includes CD-ROM discs.

PERMITTED USES

CE Software, Inc. (CE) grants you a non-exclusive license to use the Software in this Package
according to the terms set forth below. You may:

+ Operate the server Software on one computer at a time and the workstation Software on a
maximum of the Authorized Number of computers at a time. The server Software may be
installed on additional computers if they are all linked together. The activation key which
allows the operation of the Software may be installed on more than one such linked server, but
the Authorized Number may not be exceeded.

+ Make backup copies of the Software solely for archival purposes, which automatically
become the property of CE and are subject to this agreement.

+ Operate the server Software on a single (or greater number as allowed above) hard disk drive
or other permanent storage device for your own use and keep the original diskette as a backup
copy; and operate the workstation Software, including any part thereof, on a maximum of the
Authorized Number of hard disk drives or other permanent storage devices for your own use.
« After written notification to CE, transfer all (but no lesser portion) of the Software and
related manuals to another person or entity, who in turn will be subject to this agreement.

PROHIBITED USES

You may not:

* Modify, reverse-engineer, disassemble, decompile or reduce the Software to a human
perceivable form or translate, sub-license, resell for profit, lend, rent, or lease any portion of
the Software.

« Distribute the Software electronically over a network except to facilitate the otherwise
legitimate installation of the Software.

« Make copies of the copyrighted manuals.

+ Merge it with another program or create derivative works based on the Software.

« Remove, obscure, or alter any notice of the CE copyright or other proprietary legends on the
Software.

« Transfer the Software or any direct product to any person or entity in violation of the United
States Export Administration Act.

The Software involves valuable proprietary rights of CE and others. CE retains title to and
ownership of the Software and all copyright, trade secret, trade name, trademark, and other
property rights related to the Software, regardless of the form in which the original or other
copies exist. You may not violate these rights, and you must take appropriate steps to protect

CE’s rights. You are responsible for all taxes other than those based on the net income of CE.
CE may at any time replace, modify, alter, improve, enhance, or change the Software.

U.S. GOVERNMENT RESTRICTED RIGHTS

The Software and documentation are provided with RESTRICTED RIGHTS. Use,
duplication, or disclosure by the Government is subject to restrictions as set forth in
subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at
DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-
Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is CE Software, Inc., P.O.
Box 65880, West Des Moines, IA 50265.

TERMINATION

Both the license and your right to use the Software terminate automatically if you violate any
part of this agreement. In the event of termination, you must immediately destroy all copies of
the Software or return them to CE.

LIMITED WARRANTY

CE warrants that, upon delivery by CE, the diskettes on which the Software is distributed will
be free from defects in materials and workmanship and that the Software will substantially
conform to the specifications established by CE. CE does not warrant that the Software is free
from all bugs, errors, and om ns. If any of the Software fails to comply with this limited
warranty, CE will replace the diskette or, at CE’s option, make a reasonable effort to correct
the program errors. You must, however, return your original diskette(s), along with a copy of
your paid invoice, to CE or its authorized representative within 90 days of the date you
received the Software. If CE is unable to correct defective diskettes or program errors, CE
will refund all or a fair portion of the price you paid for this Package. The refund will fully
satisfy your claims for Software or diskette failure. This limited warranty shall continue for
any replacement Software for the rest of the original 90-day warranty period or for 30 days
from the date you receive the replacement, whichever is longer. CE’s liability to you for
actual damages for any cause whatsoever, and regardless of the form of the action, will be
limited to the greater of $100 or the money paid for the Software that caused the damages.

EXCEPT AS SPECIFICALLY SET FORTH ABOVE, CE DISCLAIMS ALL OTHER
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND
YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE.

EXCEPT AS SPECIFICALLY SET FORTH ABOVE, CE AND ITS DISTRIBUTORS AND
DEALERS WILL IN NO EVENT BE LIABLE FOR ANY DAMAGES WHATSOEVER FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES, EITHER DIRECT OR INDIRECT,
INCLUDING BUT NOT LIMITED TO LOSS OF BUSINESS PROFITS, INCOME OR USE
OF DATA. SOME STATES DO NOT ALLOW EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES; THEREFORE, THE LIMITATIONS
SET FORTH IN THIS AGREEMENT MAY NOT APPLY TO YOU.

GENERAL

This agreement constitutes the entire agreement and supersedes any prior agreement between
CE and you concerning the contents of this Package. CE is not bound by any provision of any
purchase order, or other document, unless CE specifically amends this agreement. This
agreement cannot be amended, modified, or waived, unless the change is written and signed
by an authorized corporate officer of CE.
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